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01.// PURPOSE OF THE DOCUMENT 

Blender is an open-source program for 3D modeling, widely used in the field of graphic design. Thanks to its 

open nature, Blender allows the incorporation of extensions and add-ons, add-ons developed by professionals 

from various sectors that provide additional functionalities to the software.  

This manual provides a basic guide  for the use of Blender 3D in conjunction with the Bonsai extension and 

other useful add-ons in the context of BIM methodology. 

The aim is to encourage the use of open source tools in the implementation of the BIM methodology, thus 

promoting flexibility and accessibility in the design and modelling processes.  
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02.// SOFTWARE VERSION 

The specifications of Blender used in the drafting of this document are as follows:  

 

BLENDER 

Full Name Software Blender 3D 

Version 4.2.0 

Date of writing the tutorial September 2024 

Name of developer company Blender Foundation 

Web developer company https://www.blender.org/ 

Community Support Forum https://www.blender.org/community/ 

Development Team https://www.blender.org/about/people/ 

 

It is recommended to work the program with the English interface 

The specifications of Bonsai used in the drafting of this document are as follows:  

 

BONSAI 

Name extension Bonsai 

Version 0.8.0 

Date of writing the tutorial September 2024 

Powered by ifcOpenShell 

Website https://www.bonsaibim.org/ 

Community Support Forum 
https://community.osarch.org/ 

https://bonsaibim.org/community.html 

 

The versions in use, both Blender and Bonsai, appear in the lower right corner of the screen:  

 

 

https://www.bonsaibim.org/
https://community.osarch.org/
https://bonsaibim.org/community.html
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03.// INSTALLING BLENDER AND 

EXTENSIONS  

To install Blender, first access the official download site (https://www.blender.org/download/) and select the 

version you need. 

Starting with version 4.2 of Blender, add-ons have been renamed "extensions". These are available on the 

official Blender extensions page (https://extensions.blender.org/add-ons/). However, some add-ons are not 

yet listed on this site. 

The following extensions and add-ons are recommended below: 

Node Wrangler: new shortcuts to improve workflow with tools that include visual programming such as 

Geometry Nodes and the Shader Editor. 

https://www.youtube.com/watch?v=XTVWy4IIH3A 

MeasureIt: tool to generate precise measurements leaving graphics very similar to the dimensions of 

the planes with which you work in reality. 

https://www.youtube.com/watch?v=7hKCDfYOsC8 

Align Tools: new parameters that are used to align objects with respect to each other in location, 

scale or rotation. If we click on advanced options it will let us align these objects with respect to the 

pivot of the object itself or the global cursor. 

https://www.youtube.com/watch?v=XicAUZ3GAA8 

Loop Tools: Additional options to editing Edge Loops. 

https://www.youtube.com/watch?v=o4LopQs2bBQ 

Bool Tool: new interface that makes it easier to create pours, joints and intersections.  

https://www.youtube.com/watch?v=A7LpZKCjF7k 

Bonsai: https://extensions.blender.org/add-ons/bonsai/ Add-on that allows you to generate ifc, export 

and import ifc, as well as edit ifcs without any restriction. 

Blenderkit: https://www.blenderkit.com/ Add-on that acts as an Assets library to import them into 

the 3D model, from objects, textures to displacement maps and EXR. 

Sverchok: https://github.com/nortikin/sverchok add-on whose use is the parametric design that 

serves as an alternative to the function integrated in blender Geometry Nodes. Sverchok nodes can be 

integrated directly into the IFC file allowing direct generation and is perfectly compatible with 

BlenderBim 

Blender GIS: https://github.com/domlysz/BlenderGIS Addon Add-on to work with GIS elements, 

allows the import of ascii, tiff, shp files... This way we can import the terrain where we work, facilitating 

the visualization and calculations of the result of the project.   

 

 

 

 

 

 

https://www.blender.org/download/
https://extensions.blender.org/add-ons/
https://www.youtube.com/watch?v=XTVWy4IIH3A
https://www.youtube.com/watch?v=7hKCDfYOsC8
https://www.youtube.com/watch?v=XicAUZ3GAA8
https://www.youtube.com/watch?v=o4LopQs2bBQ
https://www.youtube.com/watch?v=A7LpZKCjF7k
https://extensions.blender.org/add-ons/bonsai/
https://www.blenderkit.com/
https://github.com/nortikin/sverchok
https://github.com/domlysz/BlenderGIS
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To install the extensions from the browser, simply drag them directly into the Blender window. In the case of 

add-ons that are not found on the extensions page, they must be loaded directly from the file saved on your 

computer. 

 

 

 

Once installed, it searches in the browser of the add-on window and activates: 
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04.// OPTIMISATION 

To optimize the performance of Blender, we recommend that you make the following configurations:  

1. System Preferences 

Go to Edit > Preferences and access the System section . 

Select OptiX and check all the available boxes under Cycles Render Devices, including those 

where the CPU and GPU are listed. This allows Blender to use the maximum capacity of its 

available hardware for rendering. 

2.Undo Steps Settings 

Set the value of Undo Steps to 256. Having multiple backsteps is always helpful for reverting 

unwanted changes more flexibly. 

3. Online Access 

Enable the Allow Online Access option  to allow Blender to access online resources that could 

improve its operation. 

4. Auto-Save 

In the Save & Load section, enable the Auto-Save option  and set the auto-save time interval 

that you think is appropriate for your work pace. Note that this autosave is stored in the 

temporary folder and not in the location of the original file, serving as a backup in case of an 

unexpected program closure. 

It is recommended to save your work regularly using the shortcut Ctrl + S  to ensure that the 

changes are preserved in the desired location.  

These settings will help improve the stability and performance of Blender, as well as minimize potential work 

losses. 
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05.// OBJECT MODELING AND MODIFICATION 

This section deals with the creation of geometry and its modification to adapt it to the specific needs of the 

project in which you are working. 

5.1 GETTING STARTED, TOOLS AND SHORTCUTS  

The letters G (Grab), S  (Scale), and R (Rotate) are critical in Blender, as they allow you to move, scale, and 

rotate objects respectively. It's important to familiarize yourself with these shortcuts. In addition, these 

parameters can be restricted to one of three axes: X and Y (horizontal axes from north to south), and Z 

(vertical axis of height). Pressing the Shift  key  together with the axis makes an exclusion selection. For 

example, when using G+X +Shift , the object will move in the Z and Y axes, excluding the X-axis. 

In the Tool Bar on the left, you will find the gizmos of each tool to make the work easier. If they are not 

displayed, they can be displayed by pressing the T key . 

 

           

 

          

 

 

To view changes numerically, the Item tab  on the right displays the object's location relative to the global 

cursor, its rotation, and scale. This menu can also be opened with the N key . 



BIM Manual: Annex 12 – Appendix 1          Basque Railway Network 

 

 

9 

 

 

              

 

These modifications will be applied to the object we have in the scene, in its entirety  

Under the options bar (File, Edit, Render, Window, Help), you will find the options: Workspace, Mode 

Selector, View, Select, Add,  and Object.  

In the Add section  , all the options for creating different types of geometries, curves, and other elements that 

can be added to the scene are available. The shortcut Ctrl + A can also be used. 

To modify the geometry of the different elements that make up an object (vertices, edges or faces) it must be 

done in Edit Mode. 

 

 

 

The tools that exist in Edit Mode are the following: 

Inset I: Creates a new face within the selected one and scales it to a smaller size.  

Extrude E: Allows you to extrude the geometry according to the normal ones or lock the extrusion to 

the three coordinate axes. Alternatives to normal ones can be explored with Alt + E. 

Loop Cut Ctrl + R: Create cuts in the part using adjacent quads as a reference, being able to distribute 

them evenly or adapt the shape to the edges of the quads. 

Bevel Ctrl + B: Truncates selected edges, allowing them to be rounded or given specific shapes with 

a custom profile. 

Spin (Tool Bar): Duplicates an object radially around a reference point.  

Knife K: Cut the faces of the geometry to create new shapes or clean up the mesh. 
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In Edit Mode, you can change the type of selection (vertices, borders, faces) using the top icons or the 

numbers 1  (vertices), 2  (edges), and 3  (faces) on the numeric keypad. Right-clicking opens a menu with 

useful options for each selection mode. To access vertex options in other modes, the shortcuts Ctrl + V  

(vertices), Ctrl + E  (edges), and Ctrl + F  (faces) are used. 

 

 

 

The Merge tool  allows you to merge elements by selecting at least two faces, edges, or vertices, and pressing 

the M key . 

Links to tutorials on these tools are attached: 

https://www.youtube.com/watch?v=B0J27sf9N1Y&list=PLjEaoINr3zgEPv5y--4MKpciLaoQYZB1Z&pp=iAQB 

https://www.youtube.com/watch?v=At9qW8ivJ4Q 

5.2 SPECIFIC TOOLS 

In addition to the tools mentioned, there are additional options such as:  

Pivot Point: Defines how transformations are applied. 

Snap: Moves elements along fixed increments of the grid or to surfaces/edges of other objects.  

Proportional Editing (Fall-off): Allows geometry to be edited proportionally and smoothly with 

different mathematical parameters 

https://docs.blender.org/manual/en/latest/editors/3dview/controls/snapping.html#snap-to 

https://docs.blender.org/manual/en/latest/editors/3dview/controls/proportional_editing.html#proportional -

editing 

 

5.3 MODIFIERS 

Here are the most relevant modifiers in the common workflow: 

Geometry Nodes: Allows totally procedural and parametric designs and animations. 

https://www.youtube.com/watch?v=B0J27sf9N1Y&list=PLjEaoINr3zgEPv5y--4MKpciLaoQYZB1Z&pp=iAQB
https://www.youtube.com/watch?v=At9qW8ivJ4Q
https://docs.blender.org/manual/en/latest/editors/3dview/controls/snapping.html#snap-to
https://docs.blender.org/manual/en/latest/editors/3dview/controls/proportional_editing.html#proportional-editing
https://docs.blender.org/manual/en/latest/editors/3dview/controls/proportional_editing.html#proportional-editing
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https://www.youtube.com/watch?v=8L9fV8P_HAM&list=PLgO2ChD7acqHzccBuhAGw8dTPLnR1E3QB&p

p=iAQB 

https://www.youtube.com/@Erindale 

https://docs.blender.org/manual/en/latest/modeling/geometry_nodes/index.html  

Generate: Modify the geometry as in Edit Mode, with non-destructive tools. 

Array: Duplicates an object in a specific direction. 

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/array.html  

Bevel: Rounds edges globally. 

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/array.html  

Boolean: Performs mathematical operations (intersection, union, difference) between objects.  

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/booleans.html  

Mirror: Creates a duplicate on the selected axis. 

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/mirror.html  

Screw: Duplicates an object in a helical shape. 

https://docs.blender.org/manual/en/latest/modeling/meshes/editing/edge/screw.html  

Solidify: Generates a solid edge on hollow objects. 

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/solidify.html  

Wireframe: Creates a profile based on the edges of the object. 

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/wireframe.html  

Deform: Warps geometry based on external parameters. 

Displace: Shift geometry using a black and white map. 

https://docs.blender.org/manual/en/latest/modeling/modifiers/deform/displace.html  

Simple Deform: Deforms geometry by twisting or bending it according to controllable parameters.  

https://docs.blender.org/manual/en/latest/modeling/modifiers/deform/simple_deform.html  

 

With these tools and modifiers, great versatility can be achieved in 3D modeling, adapting to various needs 

and projects. 

The following link explains all the modifiers offered by Blender: 

https://www.youtube.com/watch?v=ov0F3cEJWoI 

https://www.youtube.com/watch?v=8L9fV8P_HAM&list=PLgO2ChD7acqHzccBuhAGw8dTPLnR1E3QB&pp=iAQB
https://www.youtube.com/watch?v=8L9fV8P_HAM&list=PLgO2ChD7acqHzccBuhAGw8dTPLnR1E3QB&pp=iAQB
https://www.youtube.com/@Erindale
https://docs.blender.org/manual/en/latest/modeling/geometry_nodes/index.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/array.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/array.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/booleans.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/mirror.html
https://docs.blender.org/manual/en/latest/modeling/meshes/editing/edge/screw.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/solidify.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/wireframe.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/deform/displace.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/deform/simple_deform.html
https://www.youtube.com/watch?v=ov0F3cEJWoI
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06.// METHODOLOGY OF WORKING WITH THE 

BONSAI EXTENSION 

6.1 INTRODUCTION TO BONSAI EXTENSION 

Bonsai is an add-on designed specifically for Blender that allows the creation and modification of IFC models 

natively, facilitating workflows typical of the BIM environment in a single software. Among its main 

functionalities are: 

IFC Model Viewing and Exploration: Allows you to view and explore IFC models, as well as access 

all their properties. 

IFC Data Editing and Extraction: Provides the ability to edit and extract attributes, properties, and 

metadata directly from IFC data. 

Creation and Modification of Geometries: Facilitates the creation and modification of the 

geometries of the model, adjusting them to the requirements of the project.  

Generation of Plans, Sections and Elevations: Provides tools to generate graphic documents such 

as plans, sections and elevations of the 3D model. 

Creation of Schedules: Allows you to develop schedules for project planning and monitoring. 

Conflict Detection: Offers tools for detecting conflicts within the model, improving coordination and 

avoiding construction errors. 

Non-Geometric Data Integration: Facilitates the integration of additional data such as costs, asset 

management, and other aspects relevant to project management. 

Bonsai optimizes workflow by bringing together in a single environment capabilities that normally require 

several programs within the BIM methodology. 

For optimal use of this tool, it is recommended to use the documentation generated on the website of the 

application itself https://docs.bonsaibim.org/ 

6.2 EXPLORING THE BONSAI INTERFACE 

The Bonsai extension  in Blender is organized in an interface that makes it easy to work with IFC models. The 

essential elements of this interface are explained below: 

To open an existing IFC file, you need to head to the File tab  and choose the Open IFC Project option. When 

you open the file, you will be presented with three distinct zones in the Bonsai interface. 

Zone 1: IFC Entity Tree 

This zone shows a hierarchical tree of all IFC entities present in the model. It functions as a navigation 

panel, allowing the user to explore and select different parts of the IFC model as needed.  

Zone 2: 3D Geometry Visualization 

The geometry of the IFC model in a 3D environment is shown here. This view allows you to visualize 

and manipulate the graphical representation of the model, facilitating interaction with its physical 

structure. 

Zone 3: Non-Graphical Data of the 3D Model 

This is the area where Bonsai work is mainly focused. It presents the non-graphical data of the IFC 

model, such as attributes, properties, metadata, and any additional relevant information. This area is 

https://docs.bonsaibim.org/
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critical for editing and managing information that is not directly represented in 3D geometry, such as 

material properties, construction data, and asset management details.  

The Bonsai interface is designed to provide efficient and direct access to both the geometry and associated 

data of the IFC models, optimizing their handling and manipulation within Blender.  

 

 

 

In Zone 3 of the Bonsai interface, a series of tabs are presented that allow you to navigate through the 

different properties and uses of the IFC model. Each tab provides access to different types of information and 

functionality related to the non-graphical data in the model.  

For this manual, we will explain only the use of the first two tabs, which are the most relevant for basic handling 

of an IFC model: 

 Project Overview: This tab allows you to view and edit the basic properties of the elements of the IFC 

model. Here are attributes such as name, identification, object type, material, and other essential metadata 

that describe the general characteristics of each entity within the model. Their use is essential to make quick 

adjustments and ensure that all elements are correctly documented. 

 Object Information: This tab accesses the specific attributes of the selected elements, such as 

dimensions, technical parameters, and other detailed properties that depend on the type of entity (such as 

walls, windows, structures, etc.). This tab is key to customizing the model according to the needs of the project, 

allowing you to modify specific aspects and guarantee the accuracy of the data.  

 

This manual will focus on guiding the user through the handling of these two tabs, providing the foundation for 

efficiently exploring and using the properties and attributes of the IFC model in Blender using Bonsai.  
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To generate a new IFC model with the Bonsai extension, a new Blender file must first be created. To do this, 

head to the File tab  and select New to open a blank Blender file.  

Next, on the Project Overview tab  of the Bonsai extension, choose the IFC 4x3 scheme. This ensures that 

the new project conforms to the most up-to-date standard for IFC modeling. 

Note that if you decide to open a new IFC file directly from the File tab, Blender will default to the IFC 4 

scheme. For this reason, it is preferable to first create a new Blender file and then manually select the IFC 

4x3 schema  in Project Overview. 
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6.3 ORGANIZATION OF THE STRUCTURE 

To manage IFC models efficiently with the Bonsai extension, it's important to familiarize yourself with the 

features of the Project Overview and Object Information tabs. 

   Project Overview 

Some of the functions of this section are described below: 

Project Info: Provides access to the general data of the project, allowing you to consult and manage 

the basic and fundamental information of the project. 

 

 

 

Spacial Decomposition Allows you to visualize the structure of the IFC schema and make 

modifications to that structure. (For details, see point 6.5). 

 

 

Project Setup 

Links: Allows multiple IFC models to be combined and integrated into a single work 

environment, facilitating federation and coordination between different parts of the project.  
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buildingSMART Data Dictonary: is a tool that provides a standardized way to define and 

describe terms, concepts, and attributes in the construction field. It allows you to choose 

different dictionaries in order to classify the different elements.  

Classifications Activates the classification that you want to use on the different elements. 

The classification of each element is explained in point 6.6. 

 

 

Property Set Templates: Allows you to create a custom property set template (Pset) to fit 

each user's needs. These properties can be reused in other projects that require them.  

 

            

 

To generate a pset template, see the following tutorial 

https://www.youtube.com/watch?v=nlSM593swZY 

As for ETS-specific Pset, such as the 'pSet_ETS.ifc' file, these can be added to different 

projects. To be available, they must be saved to the following location in the system: 

C:\Users\usuario\AppData\Roaming\Blender 

Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bonsai\bim\data\pset 

Geometry 

Georeferencing: Allows the incorporation of the necessary data for the georeferencing of IFC 

models 

https://www.youtube.com/watch?v=nlSM593swZY
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  Object Information 

Some of the functions of this section are described below:  

Object Metadata: Displays the IFC entity assigned to an object, as well as its metadata. The 

assignment of the entity type can be modified as necessary (see point 6.5).  

Attributes: Displays the object's own attributes, such as the GlobalID, object name, 

PredefinedType, and more. These attributes can also be modified (see point 6.5). 

Spatial Container: Indicates which spatial entity the object is located in and allows it to be 

reassigned to another spatial entity, if necessary (see point 6.8).  

Property Sets: This section lists all the properties associated with the object. Section 6.7 

explains how properties can be added. 

 

 

6.4 GENERATION OF GEOMETRY 

Bonsai allows you to generate IFC files natively. Section 6.2 of this document explains how to create a new 

IFC file and select the schema you want to use. 
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By default, Bonsai creates a schema with a number of entities that can be modified, as detailed in point 6.5 of 

this document. 

 

Spatial entities can be modified and added from the Project Overview/Spatial Decomposition tab. This 

process is explained in section 6.5 of this document. 

The different objects can be added using the drop-down available in the Bonsai extension, which is mainly 

designed for building elements, or through Blender's  own Add tab  .  

Objects added using the Bonsai extension are already assigned their corresponding IFC entity by default. 

However, objects added through the Add tab  of Blender must be manually assigned to an IFC entity. 

  

6.5 MAPPING IFC ENTITIES OF GEOMETRY  

Bonsai allows you to map and adjust the entities of an existing IFC file.  
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To make changes to any entity, the corresponding null object must first be selected in Zone 1 of the dashboard. 

 

 

The hierarchy tree is located in the Project Overview / Spatial Decomposition tab, from where levels can 

be added or removed according to the needs of the project.  

 

 

To change the entity type of tree structure, you use the Object Information/Object Metadata tab, selecting 

the entity with the null object symbol. The name of the entity within the hierarchy tree can be edited in the 

Attributes section. 

              

 

If you need to map the IFC entity of a 3D object, select the object with the "▽" symbol in Zone 1 of the panel. 

This will make the object stand out in Zone 2, allowing Zone 3 to make all the necessary modifications: reassign 

an IFC class, rename it, define its location in the hierarchy tree, and add or update its properties.  
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6.6 CLASSIFICATION AGGREGATION 

To effectively manage IFC models with the Bonsai extension, it is important to apply classifications to objects 

using Classification References, especially if you have enabled the buildingSMART Dictionary (bSDD) option in 

the Project Overview section. This ensures that objects in the model are classified according to established 

classification standards and dictionaries. 

It is recommended to work without having the Filter Active IFC Class option enabled. This will allow you to 

view and manage all the elements of the model without restrictions, facilitating a more complete and flexible 

handling of the IFC model. 
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6.7 PROPERTY AGGREGATION 

Bonsai allows you to include in each object the properties that are considered necessary, by default it includes 

the following psets: 

 

You can add user-defined pset by first generating a template as explained in point 6.3. Next, in the Object 

Information/Object Metadata/Property Sets tab  , select the template you want to complete, which can 

be edited at any time. 

6.8 EXPORT TO IFC 

In the same section where it has been shown how to import an IFC file, the option to save it also appears. If 

we select this option, a dialog box appears that will show the location where it will be saved and if, additionally, 

we want a json file from the IFC. 

6.9 BSI VALIDATOR CHECK 

For this process, only the BIM validator is used. 
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To check our files we will use the service that provides us https://authentication.buildingsmart.org. It will allow 

us to upload the file and see if it has any errors. When uploaded, it will display three error fields, the schema, 

the rules in the hierarchy, and the buildingSmartDataDictionary.  

Selecting the errors will bring up a new tab with a file summary and with the errors of each section (there is 

no section that shows all 3 fields at the same time). 

 

There are two errors in this file; one on syntax in the IFC scheme and another in the Rules.  

6.10 CORRECTION AND ADJUSTMENTS  

If you want to correct the errors that are detected through the validator, as it is open source software, it is 

recommended to ask in the following forums: 

https://bonsaibim.org/community.html 

https://community.osarch.org/ 

 

https://authentication.buildingsmart.org/
https://bonsaibim.org/community.html
https://community.osarch.org/
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07.// METHODOLOGY OF WORKING WITH THE 

BLENDER GIS ADDON 

7.1 INTRODUCTION TO BLENDER GIS ADDON 

One of the advantages of using Blender in the GIS field is its ability to visualize terrain in 3D along with its 

corresponding orthophoto. This allows the areas of work to be geographically contextualized, facilitating a more 

complete and detailed analysis of the environment. 

 

 

 

Blender-GIS is an add-on for Blender that facilitates the import of commonly used GIS (Geographic 

Information Systems) data formats, such as vector Shapefile, raster images, DEM in GeoTIFF format, and 

OpenStreetMap XML files. Among its main functionalities are: 

- Import of vector contour lines, creation of faces by triangulation and application of topographic 

textures in raster format. 

- Obtaining geodata directly from the web, allowing the visualization of dynamic web maps within 

the 3D view of Blender. 

- Extraction of OpenStreetMap data, including information on buildings, roads, and other elements. 

- Management of the georeferencing information of a scene. 

- Generation of terrain meshes by means of Delaunay triangulation and placement of objects in 

these meshes. 

- Carrying out terrain analysis using shading nodes. 

This tutorial will focus on explaining how to visualize terrain meshes using the data downloaded from the official 

pages, and using the supporting QGIS software. 

To learn about other functionalities and uses of Blender-GIS, it is recommended to consult the following 

tutorial: https://github.com/domlysz/BlenderGIS/wiki/Quick-start 

https://github.com/domlysz/BlenderGIS/wiki/Quick-start
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7.2 EXPLORING THE BLENDER-GIS INTERFACE  

The interface of this plugin is very simple to use. To work with data downloaded from sites such as PNOA or 

GeoVisor Euskadi, you only need the Georeferenced raster and ESRI ASCII Grid  commands.If you want to 

include buildings in the scene, you must also import files in Shapefile format.  

 

 

 

7.3 QGIS-BLENDER WORKFLOW 

The steps to follow to visualize terrains in 3D with Blender-GIS are as follows: 

1. Downloading the terrain and orthophotos  

Get the Digital Terrain Model (DTM) or Digital Surface Model (DSM) depending on the needs of the project, 

along with their corresponding orthophotos: 

CNIG Download Center 

GeoVisor Euskadi 

2. Trimming the project area in QGIS 

 

Open the downloaded files in QGIS to trim the area of interest. 

Add both as raster layers and select the area you want to work on. 

https://centrodedescargas.cnig.es/CentroDescargas/buscadorCatalogo.do?codFamilia=LIDAR
https://www.geo.euskadi.eus/geobisorea


BIM Manual: Annex 12 – Appendix 1          Basque Railway Network 

 

 

25 

 

Use the "Cut raster by extension" option to delimit the work area. 

During the trimming process, select "Save to File." 

Choose ASCII format  for terrain mesh files and TIF for orthophotos 

 

 

 

3. Preparing the environment in Blender 

Open Blender and delete the elements that appear by default in the scene. 

4. Importing the ground mesh 

Go to the GIS/Import tab  and select ESRI ASCII Grid 

Choose the previously trimmed workspace in QGIS 
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5. Orthophoto overlay 

On the same GIS/Import tab, select Georeferenced Raster 

 

 

 

Make sure to check the **Base on Mesh** option so that the orthophoto "sticks" correctly on the ground.  

 

These steps will allow you to visualize and work with the terrain in 3D and its orthophoto in Blender, providing 

a detailed geographic context for your project.  

It can also be selected as an ifc file and exported with a corresponding entity  
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08.// LINKS OF INTEREST 

This section compiles the main links of interest. 

8.1 BLENDER & BONSAI 

BLENDER 

https://www.blender.org/ 

Blender 4.2 Manual 

BONSAI 

https://bonsaibim.org/ 

https://docs.bonsaibim.org/ 

FORUMS 

https://www.blender.org/community/ 

https://osarch.org/ 

Manual Bonsai 

8.2 OTHER 

VIDEO TUTORIALS 

https://www.youtube.com/watch?v=B0J27sf9N1Y&list=PLjEaoINr3zgEPv5y--4MKpciLaoQYZB1Z&pp=iAQB 

https://www.youtube.com/watch?v=At9qW8ivJ4Q 

https://www.youtube.com/watch?v=8L9fV8P_HAM&list=PLgO2ChD7acqHzccBuhAGw8dTPLnR1E3QB&pp=iAQB 

https://www.youtube.com/@Erindale 

https://www.youtube.com/watch?v=ov0F3cEJWoI 

https://www.youtube.com/watch?v=nlSM593swZY 

 

 

 

https://www.blender.org/
https://docs.blender.org/manual/en/4.2/index.html
https://bonsaibim.org/
https://www.blender.org/community/
https://osarch.org/
https://www.youtube.com/watch?v=B0J27sf9N1Y&list=PLjEaoINr3zgEPv5y--4MKpciLaoQYZB1Z&pp=iAQB
https://www.youtube.com/watch?v=At9qW8ivJ4Q
https://www.youtube.com/watch?v=8L9fV8P_HAM&list=PLgO2ChD7acqHzccBuhAGw8dTPLnR1E3QB&pp=iAQB
https://www.youtube.com/@Erindale
https://www.youtube.com/watch?v=ov0F3cEJWoI
https://www.youtube.com/watch?v=nlSM593swZY
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09.// ANNEXED  

9.1 IFC FORMAT EXAMPLE MODEL 


